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Introduction
General

| __[J

1.1

1.2

Introduction

General

When a fire is detected in your facility nothing protects your people and property
like a Siemens Fire Safety system solution.

The detection of smoke is an essential part of any fire safety system. If by-products
of the early stages of fire are detected, this provides an early warning long before
smoke arises

and thus creates time for actions that are designed to protect people and property
before loss is inevitable.
Siemens aspirated smoke detectors give you this early protection.

The ASD Asyst Tool is an integral part of the design and installation of an aspirated
smoke detector (ASD) system.

ASD Asyst tool

The Asyst Tool assists in the design of pipe layouts well before construction of an
actual pipe system is commenced and can also be used prior to any upgrade of an
existing ASD system.

The Asyst Tool allows the operating conditions and requirements to be entered,
and then simulates the flow of air and smoke through a pipe system connected to
an ASD system. This enables any number of provisional pipe layouts to be tested
for compliance with local regulations prior to any construction commencing.

The Asyst Tool treats each aspirated smoke detector and the piping connected to it
as a project. Each project can be saved to a file and printed at any time.

Project files can be stored on any storage medium and can be emailed, allowing
them to be opened by the Asyst Tool on other computers.

The Asyst Tool does not replace the need to compliance-test the completed
installation.
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Introduction

Use of the ASD Asyst Tool

1.3
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Use of the ASD Asyst Tool

To use the Asyst Tool with a project, enter the details of the project, select the
detector and fire standard, and enter the proposed design of the pipe layout
connected to the detector and the environmental conditions at the project site.

You can calculate or combine the flow through each pipe, or use the Asyst Tool to
propose a solution.

Compare the results with the requirements of the selected fire standard. If the
results do not comply with the fire standard then modify the proposed design and
re-evaluate the results. Repeat this process until a satisfactory result is obtained.

The Asyst Tool permits a number of designs to be tested and compared, resulting
in the most suitable installation layout being established.

Select the Asyst Tool user language with menu function 'Configuration' -
'Language'.

{§ Asyst Siemens Aspirated Smoke Monitoring System I ] 3

File Tools | Configuration | Help
|) New [ Opg Language > Deutsch
Measurement 3 Englisch |
- Mode 4 Franzosisch
Zone Details s =
Hole Size Precision » Italienisch
Print Format » Spanisch Mode
Change Hardware Reference File ' Normal
File Locations @ Scientific
City |
State I
Post Codel/Zip I
Country I ¥ -
Contact | ‘. b

Zone I

-
Fl i 1 q "
- { o i gt

Drawing Reference I “ o] ‘ - 5
: R o= e
1 ' [t Sl D
: ‘ |

Installer I

Calculated By I

Date |__.__.____

File Name |

Comments

Continue
| [

Sdentific

Figure 1 Selecting the user language
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Fire Simulation
Start Screen

2 Fire Simulation

2.1 Start Screen

Figure 2 shows the start screen:

I, Asyst Siemens Aspirated Smoke Monitoring System _

Asyst

Quit Next

SIEMENS

Figure 2 ASD Asyst Tool start screen

® Click on the 'Next' button to continue or the 'Quit' button to exit the Asyst Tool.

2.2 Disclaimer
Figure 3 shows the disclaimer.

License(AGREEMENT)

1

IMPORTANT- READ CAREFULLY: This LICENSE AGREEMENT is between You (either an individual, a legal entity or any affiliated companies or
other entities) and Siemens Switzerland Ltd., (Siemens). The LICENSE AGREEMENT authorizes You to use the Licensed Software, specified in
Clause 1 below, under the terms and conditions set forth below. Read this LICENSE AGREEMENT carefully before installing or using the
Licensed Software. By installing, copying, and/or using the Licensed Software, You acknowledge that You: (1) have read and understood the
LICENSE AGREEMENT as well as each of the Open Source Software licenses (OSS Licenses) set forth in the About Box of the Licensed Software
and in the respective license dialogue (under OSS Licenses). (2) agree to be bound by all of the terms and conditions for this LICENSE
[AGREEMENT and such OSS Licenses . You further agree that if Siemens or any licensor of Siemens is required to engage in any proceeding,
legal or otherwise, to enforce their rights under this LICENSE AGREEMENT, Siemens and/or its licensor shall be entitled to recover from You, in
addition to any other sums due, reasonable attorney’s fees, costs and disbursements. If You do not agree to all of the terms and conditions of this
LICENSE AGREEMENT, Siemens is unwilling to license the Licensed Software to you. In such an event. you should not install the Licensed
Software and promptly contact Siemens for instructions on return of the Licensed Software.

Decline Accept

|

Figure 3 Disclaimer

button to return to the start screen.

® Read the disclaimer and click on the 'Accept' button to continue or the 'Decline’
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Fire Simulation

Main Screen — Menu Functions and 'Zone Details' Screen
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2.3 Main Screen — Menu Functions and 'Zone Details'

Screen

Figure 4 shows the main screen of the Asyst Tool before creating a project.

& Aupst  Sirenens Aspirsted Smoke Monitorng Systems

Fle Tosk Confgueshon el

JMem 500 ol Seve (Pt | i wow, pemerg. com

Zone Detais |

ey |

Stheet |

= |

Staim |

Post Codeip |

L‘.numh'l

Comact |

Zona |

Fhall

Dlw'lgﬁahrmi

instabiesr |

Caloulnied By |

-

T reny |

hiE

™ Womal
= Scientiic

Commens

&

Sowrife

Figure 4 'Zone Details' screen
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Fire Simulation
Main Screen — Menu Functions and 'Zone Details' Screen

231

2311

23.1.2

2313

| __[J

2314

2315

| __[J

Menu Functions
Area 'S1' contains the menu functions.

File
Under the 'File' menu function ('S1'), it is possible to create new projects, call up

stored projects, save an open project at any time, save a previously stored project
with a new name, preview a project before printing it, and print the project.

Up to the last five opened projects are listed here; any one of these can be called
up with a single click of the mouse.

It is also possible for the Asyst Tool to be shut down here.

Tools

Under the 'Tools' menu function ('S1"), it is possible to open legacy projects created
by previous versions of the Asyst Tool, set the 'Data Backup Period' for open
projects, and select your Internet browser.

Configuration

Under the 'Configuration’ menu function ('S1'), it is possible to select a language
other than the default language English, select the metric or imperial measurement
system, and select 'Normal' or 'Scientific' mode.

The hole size precision can be selected to match the settings used by the installers
of the project (medium or fine).

Fine precision can only be used in 'Scientific' mode. This sets the hole sizes to
steps of 0.2 mm instead of 0.5 mm.

The print format can be set to either the fully configured comprehensive format or
the cut-down summary format.

The Hardware Reference File to be used can be selected and the default locations
for the storage of specific system and project files can be set.

Help

The 'Help' menu function ('S1") provides help information relating to the use of the
Asyst Tool or the design of an ASD project. The help information is displayed and
can also be printed.

You will find more information on the Asyst Tool under the 'Help' menu function.

Icons
The icons 'New', 'Open ', 'Save ', and 'Print ' provide one-click shortcuts to the
equivalent file menu functions.

The icon 'www.siemens.com' provides a one-click shortcut to open the Siemens
home page.

This icon is not available until a Hardware Reference File has been selected.
(See Figure 5.)

Area 'S2' provides a shortcut to the 'Configuration' menu function to select from the
cut-down 'Normal' mode or the fully configured 'Scientific' mode.
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Main Screen — Menu Functions and 'Zone Details' Screen

23.2

12

Zone Details

At 'S3'it is possible to store the details required to define the project. Each
aspirated smoke detector and the piping connected to it are treated as a project.
This allows each aspirated smoke detector installed at a large site to be individually
identified.

The file name of the project can be entered here or can be entered when the
project file is first saved.

The file name for an existing project can be changed either here or by using the
'Save As' menu function. This allows multiple similar ASD projects to be loaded
easily; for example, a large warehouse containing many fire zones, with each zone
protected by one aspirated smoke detector.

At 'S4' it is possible to save many lines of comments. This field could be used to
keep a record of changes for a project.

At 'S5' it is possible to load a photograph or some other image representing the
project. Any photo or image loaded here is stored in the project file allowing
complete portability of the project file either by disk or other storage media, or by
email.

Once all of the zone details have been entered, clicking on the 'Forward' button
('S6") allows the Hardware Reference File to be selected. Once this has been
selected, the remaining input and result pages are made available for use.

At 'S7', the current operating mode — 'Normal' or 'Scientific’' — is displayed.
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Fire Simulation

Main Screen - 'System Details' Screen (Scientific Mode)

2.4

Main Screen - 'System Details' Screen (Scientific

Mode)

Figure 5 shows the main screen of the Asyst Tool after selecting a Hardware

Reference File.

I, Asyst Siemens Aspirated Smoke Monitoring System

21|

File Tools Configuration Help

| ) New [z Open [gfSave (S Print |@ www.siemens.com ‘
'Zone Details System Details |Sector Details | System Results | Schematics |

Detector ||gs)ivZy] %
Fire Standard I j
[~ Sampling Hole Sensitivity Fire Alarm Settings Aspirator Power
W e Output Method
& Alarm [o.150 7 %im [4-20mA R e
@ " Pre-Alarm Parameter Set |5 3:  MID

 Oter [4.00 %m | | € InfoAlarm mA @ & Lo

[~ Transport Time Limit
' Other Ambient Temperature |23,0 :C
€ No Limit o0 = sec bsolute Pressure |1.01325 Bar
Altitude |0 m
Settings For Pipe Sectors
Number of Pipes |4 53 @

“Apply Settings To — | [ PipeInternal Diameter — | [ Sample Tubes — | [ Holes per Position —

& All Pipes @ || I 16mm I~ 26mm C Yes « Single

" Pipe Number [ = ‘ " 21mm W' Other  No " Multiple

Branched Pipes — Crosswind

C No ' Uniform & No

* Yes ezl " Stepped  Yes

Sdentific
Figure 5 'System Details' screen in 'Scientific' mode
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241

Elements on the 'System Details' Screen (Scientific Mode)

At 'S8', the detector used in the project and the applicable local fire standards can
be selected from the drop-down list of available detectors and standards.

At 'S9' the target sampling hole sensitivity as set in the fire standard can be
selected or another target can be entered.

At 'S10' the target smoke transport time as set in the fire standard can be selected
or another target can be entered.

At 'S11', it is possible to display and or set the fire alarm settings and to select the
output method used by the detector to report alarms.

At 'S12', the 'Aspirator Power ' (speed of the detector) is set or displayed. If the
detector aspirator has only one setting then this input box is hidden.

Section 'S13' allows other system details to be entered. These include the 'Ambient
Temperature', the 'Absolute Pressure'at the installation site and the 'Altitude’ of the
installation site.

The number of pipes in the project is selected at 'S14'. (Default is '2")

Section 'S17' is used to define the overall design of the pipe-work system. The
options available here include:

- The 'Pipe Internal Diameter' of the piping
- Option of reducing pipe diameters in the pipe route
- The use of sample tubes (capillary tubes)

- The type of sample tubes (capillary tubes) - coiled or straight - at each sampling
hole position (up to 4 sampling holes around the circumference of the tube)
- Potential crosswind (cross airflow) at each sampling hole position

Input 'S15' allows the same 'S17' options to be applied to all of the pipes in the
project or for different 'S17' options to be applied to each pipe in the project.

Input 'S16' is used to identify that the project uses branched pipe-work. If you
select the "Yes' option, the Asyst Tool displays the screen for entering the pipe
branches.
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242

2421

2422

Specific System Inputs

The items that may be selected and the values that may be entered often depend
on the mode of operation, specific detector and fire standard selected.

Sampling Hole Sensitivity

Fire standards set targets for the smoke concentration at and around a single
sampling hole that will trigger an alarm.

Once this smoke has been drawn into the ASD pipe work and diluted with fresh air
drawn into the pipe work at all of the other sampling holes, the smoke
concentration is lower. This lower concentration becomes the fire alarm sensitivity
setting at which the aspirated smoke detector will activate an alarm.

Select to comply with the fire standard targets or enter your own target for the
smoke concentration at the sampling hole.

Example:

European standard EN 54-20 refers to the sensitivity levels of an aspirated smoke
detector as: Class A, Class B, and Class C

Class Description Example
A Aspirated smoke detector with | Very early detection: to be able to detect very diluted
very high sensitivity smoke as found in air-conditioning ducts, or
environmentally controlled areas such as clean rooms
B Aspirated smoke detector with | Early detection: to be able to detect special fire conditions,
enhanced sensitivity nearby or close to valuable and critical equipment such as
computers or electronic cabinets
C Aspirated smoke detector with | Standard detection: to be able to detect general fires in
normal sensitivity standard rooms or spaces. Offers at least an equivalent
level of detection as a point-type or beam-type detection
system

The different levels of sensitivity can be set using the Asyst Tool.

Class A

Set the Fire alarm setting to 1.5 %/m

To reach the Class A level, all the hole sensitivities must be 1.5 %/m or less.
Class B

Set the Fire alarm level to 4.5 %m

To reach the Class B level, all the hole sensitivities must be 4.5 %/m or less.
Class C

Set the Fire alarm level to 10.0 %m

To reach the Class C level, all the hole sensitivities must be 10.0 %/m or less.

Alarm Settings

This section allows you to set the alarm values to be used in the detector or display
the optimum values calculated by the Asyst Tool.

Generally the alarm actions will be defined in your fire detection system protocol or
specification. The Asyst Tool allows you to examine and work with three alarm
levels called 'Alarm’, 'Pre-Alarm’, and 'Info Alarm'. It is outside of the scope of this
document to define how these alarm levels are used by a fire safety system.
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2423

2424

2425

2426

2427

2428

2429

24210

24211

Alarm

Select the 'Alarm’ option to view or set the sensitivity value at which the detector
will activate an alarm output.

Pre-alarm

Select the 'Pre-Alarm’ option to view or set the sensitivity value at which the
detector will activate a pre-alarm output.

Info Alarm

Select the 'Info Alarm’ option to view or set the sensitivity value at which the
detector will activate an alert output.

External Filtration

Not available in this software version.

External Aspiration

Not available in this software version.

Output Method

If your detector is fitted with a 4...20 mA output for use on peripheral equipment,
the equivalent value will be displayed here.

Parameter Set

Parameter sets are used to define a range of sensitivity levels for activating an
alarm.

Aspirator Power

The aspirator power setting of the detector can be changed. The setting affects the
response time and can be selected manually. If 'Propose Solution' is selected on
the 'Sector Details' screen, a value will be set automatically.

Higher settings result in shorter response times while lower settings are more
energy efficient.

Transport Time Limit
Select whether this should comply with the fire standard limit values, or enter
different values.

If no limit is selected, the Asyst Tool will still calculate and report the transport time
but will not report if that time exceeds the value.
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Main Screen - 'System Details' Screen (Scientific Mode)

24212

24213

24214

24215

24.2.16

Ambient temperature

Enter the typical value for the ambient temperature around the aspirated smoke
detector and the piping connected to it.

Absolute Pressure

Enter the typical absolute pressure at the installation site. The Asyst Tool will then
calculate and display the altitude of the installation site. If you are unsure of the
'Absolute Pressure', enter the 'Altitude’ in the next input box.

Altitude

Once you enter an altitude value, the Asyst Tool calculates the absolute 'Absolute
Pressure'.

Pipe Internal Diameter

The internal diameter of the pipe must be known so that air velocities can be
calculated. The external diameter is not significant, except from the perspective of
load intensity.

Select from one of the standard values or enter the internal diameter of the pipe.

Bend Radius

Enter the bend radius used in the piping at the middle of the pipes. When operating
in 'Normal' mode, the Asyst Tool assumes that all bends along the piping have the
same radius.

Large bend radii do not affect the airflow or the transport time as much as small
bend radii.
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Fire Simulation
Main Screen - 'System Details' Screen (Scientific Mode)

2.4.3 Branched Pipe Details Screen
Figures 6 and 7 show the input screens for branched pipes.

Siemens Aspirated Smoke Monitoring System il

Select all pipes which are part of a branched set Enter the trunk identifier, the trunk length from the
detector to the branch and the number of sampling hole positions before the branch. Provided that
the trunk identifier has been entered for each branched pipe in a set. itis only necessary to enter the
trunk length and the number of positions before the branch, for the first pipe in the set

Pipe Number Branched Pipe Trunk |dentity Trunk Length (m) NBL;:;?:}C::S:’:Z:S
1 2 A 50 0
2 2 A 5.0 0 Apply
3 v A 50 0
4 I~

Cancel

Close

Wl =@

Figure 6 Input screen for branched pipes, option 1

Option 1
The table at 'S18' allows the details of the branched pipes to be entered.

In this example, the project contains four pipes. Pipes 1, 2, and 3 all join onto one
trunk and are identified as 'Trunk Identity A'. The length of this trunk is 5 m.
Pipe 4 is a single pipe, not part of a branched set of pipes.

Once you click on the 'Apply' button ('S19'), the Asyst Tool checks the entered
values and warns if the trunk lengths and number of sampling hole positions
conflict with the values entered for each pipe on the 'Sector Details' screen.

Clicking on the 'Cancel' button ('S20") clears the entered data, returning it to the
previous values; clicking on the 'Close' button ('S20') takes you back to the main
screen.
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Siemens Aspirated Smoke Monitoring System \ il

Select all pipes which are part of a branched set Enter the trunk identifier, the trunk length from the
detector to the branch and the number of sampling hole positions before the branch. Provided that
the trunk identifier has been entered for each branched pipe in a set. itis only necessary to enter the
trunk length and the number of positions before the branch, for the first pipe in the set

Pipe Number Branched Pipe Trunk |dentity Trunk Length (m) I\IB‘;:::}Z;P;S;':Z:S
1 2 A 10.0 0
2 2 A 10.0 0 Apply
3 v B 3.0 0
4 v B 3.0 0

Cancel

Close

Wl =@

Figure 7 Input screen for branched pipes, option 2

Option 2
The table at 'S18' allows the details of the branched pipes to be entered.

In this example, the project contains four pipes. Pipes 1 and 2 join onto one trunk
and are identified as 'Trunk Identity A'. The length of this trunk is 10 m.

Pipes 3 and 4 are identified as "Trunk Identity B'. The length of this trunk is 3 m.

Once you click on the 'Apply' button ('S19'), the Asyst Tool checks the entered
values and warns if the trunk lengths and number of sampling hole positions
conflict with the values entered for each pipe on the 'Sector Details' screen.

Clicking on the 'Cancel' button ('S20") clears the entered data, returning it to the
previous values; clicking on the 'Close' button ('S20') takes you back to the main
screen.

24.3.1 Pipe Number

The 'Pipe Number' displayed identifies the pipe and is used in all displays and
sections of the Asyst Tool software.

2.4.3.2 'Branched Pipe' Checkbox

Select which pipes are parts of a branched set of pipes and which pipes are single
pipes, by checking or un-checking the box in column two of the table.

2.4.3.3 Trunk Identity

The Asyst Tool needs to know which pipes make up each branched pipe set; it
does this by allocating the letter 'A’ to the first set, 'B' to the second, and so on.

Enter a letter beside the branched pipes to identify which set they belong to; do not
enter a letter against single pipes.
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2434 Trunk Length

Enter the length of single pipe measured from the detector to the junction of the
branched pipes. For simplicity, it only needs to be entered for the first pipe in each
branched set.

2.4.3.5 Number of Positions Before The Branch

Enter the number of sampling hole positions in the trunk of the pipe. This is the
number of positions in the pipe between the detector and the junction of the
branched pipes.

° In 'Normal' mode, sampling hole positions are not allowed in the trunk of a
1 branched pipe set; consequently, this input is not shown when using 'Normal'
mode.
20
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2.4.3.6 Schematics for Branched Pipes

Figure 8 shows an example of 'Schematics' for branched pipes.

Zone Detailsl System Detailsl SectorDetaiIsI System Results Schematics |

Pipe 1 25,0m

A 11,0m

] Pipe2 25.0m @
enies

11,0m

e Pipe3 25,0m

[ 11,0m

Pipe 4 20,0m @
4.0m

Zoom 301%

J_

Figure 8 'Schematics' screen showing branched pipes with a trunk

The 'Schematics' screen is a schematic only and is not drawn to scale.

'S21" shows trunk 'A’" and pipes 1, 2 and 3.

'S22' shows pipe 4.

The first sampling hole position on each trunk and on the single pipes is shown, as
is the length of each pipe including the trunk.

'S24' represents the manner in which the pipes are joined to the detector purely for
this schematic.
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Figure 9 shows an example of 'Schematics' for branched pipes.

' Zone Details | System Details | Sector Details | System Results  Schematics |

Pipe 1 30,0m

A 11,0m @

Pipe 2 30,0m

"% 11,0m
jlk: @
Pipe 3 20,0m
. : o @
—_—
Pipe 4 20,0m

4.0m

™

Zoom 301%

J_

Figure 9 'Schematics' screen showing branched pipes with two trunks

The 'Schematics' screen is a schematic only and is not drawn to scale.

'S21" shows trunk 'A’ and pipes 1 and 2.

'S22' shows trunk 'B' and pipes 3 and 4.

The first sampling hole position on each trunk and on the single pipes is shown, as
is the length of each pipe including the trunk.

'S24' represents the manner in which the pipes are joined to the detector purely for
this schematic.
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2.5

'Sector Details' Screen (Scientific Mode)

Figure 10 shows the 'Sector Details' screen when 'Scientific' mode is selected.

I, Asyst Siemens Aspirated Smoke Monitoring System
File Tools Configuration Help

| ) New [ Open [gfSave (S Print |@ www.siemens.com

21|

|The number of pipes in this fire zone = 4 ... This pipe is connected to pipe trunk: A

' Zone Details | System Details Sector Details | System Results | Schematics |

Pipe Number E REEEEEE End Vent |3.0 mm
" Fixed 38 m
Pipe Length |30.0 m ‘_. Ambient Relative Pressure =  |0.0 Pa
Variable
Pipe Internal Diameter |21.0 mm T e Sector Flow l/min
Bend Radius |70 mm " Fixed 25 mm System Flow limin
Number of Holes |6 3: & Variable System Flow Percentage %
Hole Position  # 1 2 3 4 5 \
Posttion m 110 | 148 | 186 || 224 | 262 | 30.0
Bends # = = = = = =
Hole Diameter mm 25 25 25 25 25 30

Pipe Pressure  Pa
Hole Flow |/min
Hole Sensttivity  %/m

Transport Time  Sec

10.0
Tm " Special Options j
I” Balanced Hole Flow @

Propose

Solution Calculate

¥ Hole Sensitivity

Scientific

Figure 10 ‘Sector Details' screen in ‘Scientific’ mode

This screen is used to enter the details of each sector (pipe) in the fire zone and
then calculate the airflow through the pipes and sampling holes.
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2.5.1 Elements on the 'Sector Details' Screen (Scientific Mode)
At 'S25' it is possible to select which pipe to edit or which pipe to view. The pipes
are numbered 1...4, allowing each pipe to be uniquely identified.

The basic details of the pipe are entered at 'S26'. These include the 'Pipe Length',
'Pipe Internal Diameter' if it is not a preset fixed pipe size, the 'Bend Radius' of the
pipe, and the 'Number of Holes', 'Hole Position’, 'Position’, and 'Bends' of the pipe.
At 'S27' select the spacing along the pipe between sampling hole positions ('Hole
Spacing') and the diameter of the sampling holes ('Average Hole Diameter').

If the spacing between the sampling holes is the same throughout, the spacing can
be entered at 'S27' with 'Fixed' selected. If the spacing between the sampling holes
varies, 'Variable' can be selected and the individual spacing details entered under
'S29'. If you select 'gaps ', you can enter the spacing between adjacent sampling
holes.

If the hole diameters are fixed then the value can be entered at 'S27': If the values
vary from position to position, selecting the relevant option allows the diameters to
be entered at 'S29'.

If you need to optimize the airflow share calculation by changing the 'End Vent'
hole size, you can do this at 'S28'.

For further accuracy regarding transport time, the 'Ambient Relative Pressure'
could also be entered at S28. If the '"Ambient Relative Pressure' is not known, leave
it at the default value '0.0'".

There is no need to enter anything at 'Sector Flow', 'System Flow', or 'System Flow
Percentage’, as the Asyst Tool calculates these values.

Section 'S29' can be used to enter the details specific to each sampling hole
position. These include:

® The 'Hole Position'
® The spacing between holes 'Position’
® The number of 'Bends' in the pipe section preceding this position

In addition to the input fields shown in Figure 10, the fields for the following options
are shown based on the pipe settings made on the 'System Details' screen and at
the top of the 'Sector Details' screen:

® Diameter of the sampling holes

Pipe internal diameter

Internal diameter and length of the sample tube
Coil radius of the sample tube

Number of holes at each sampling position
® Crosswind

A help prompt or information is displayed for most of these input fields. Hold the
cursor on the input field to view the help message.
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2.5.1.1 Pipe length

The length of a pipe is measured from the detector enclosure inlet port, to the far
end of the pipe, where the end vent is located. For simplicity, the pipe is measured
according to a square layout because any reduction in the actual length of line due
to the presence of bends is accounted for in the Asyst Tool.

2.5.1.2 Pipe Internal Diameter

Enter the internal diameter of the pipe. If the internal diameter reduces along the
pipe, enter the internal diameter at the detector. The remaining diameters can be
set in the 'S29' area.

2.5.1.3 Bend Radius

Enter the bend radius used in the pipe-work. When operating in 'Scientific' mode,
the Asyst Tool assumes that all bends along a pipe have the same radius.

Large bend radii do not affect the airflow or the transport time as much as small
bend radii.

2.5.1.4 Number of Holes (Sampling Position)

Select the number of sampling holes along the pipe.

If the 'Hole Spacing' is set to 'Fixed', the Asyst Tool will distribute the sampling hole
positions evenly. If the number of sampling holes changes, the sampling hole
positions are redistributed with the exception of the first sampling hole position.

If the 'Hole Spacing' is set to 'Variable', then the Asyst Tool will ask you to select
which sampling hole position is to be added or removed in the event that the
'Number of Holes' is changed.

Asyst - Add sampling hole position

Enter the new sampling hole position to be added

Hole Position:1-5 | W Cancel | OK |

Figure 11 'Add sampling hole position' screen

At 'S33' enter the number of the hole position to be added or to be removed. If a
position is added, the Asyst Tool spaces it midway between the adjoining sampling
hole positions. If a position is removed, the Asyst Tool adds together the adjoining
spaces.

To accept the change, click on the 'OK' button; to cancel the change, click on the
'Cancel’ button ('S34").
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2515

251.6

251.7

251.8

26

Hole Spacing

If the spacing between every sampling hole position is constant along a pipe, then
select the 'Fixed' option under 'Hole Spacing' and enter the spacing value.

If the spacing varies, then select the 'Variable' option under 'Hole Spacing'. This
allows you the enter the distances between the holes.

Place the cursor over the value in the 'Position m' row for the appropriate hole and
type in the new value which is the distance to the next hole. This field displays the
average spacing.

Average Hole Diameter

If all of the sampling holes along a pipe are the same diameter, then select the
'Fixed' option and enter the diameter.

If the sampling holes do not have the same diameter at every sampling hole
position, then select the 'Variable' option and enter the diameter for each position
at 'S29'. In this case, the average hole diameter will be displayed in this box.

End Vent

Typically the end vent is larger than other sampling holes, so that a strong airflow
comes from the end of the pipe. Otherwise, for a long pipe the smoke transport
time could be very slow indeed. However, too large a vent would impair the good
balance and share of airflow among sampling holes.

Enter the diameter of the end vent.

Ambient Relative Pressure

In computer rooms or other mechanically ventilated areas, it is possible for
individual pipes to be located in areas where the ambient atmospheric pressure is
higher or lower than the pressure at the outlet of the aspirator.

The ambient pressure differential relevant to each pipe can be entered. It is
unusual for pressure differentials to exceed 25 pascals (Pa) - at this pressure,
doors become difficult either to open or to close, or ceiling tiles may lift.
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2521

2522

2523

2524

2525

2526

Hole Input Details

The following items can be input, based on the settings selected for the pipe on the
'System Details' screen and at the top of the 'Sector Details' screen.

Position or Spacing of the Sampling Hole

Enter either the distance of the sampling hole position from the detector or, if the
'Position m' option has been selected, enter the distance from the previous
sampling hole position to this position.

Bends

Enter the number of bends 'Bends #' for each sampling hole position in this section
of pipe. Specify the number of bends between the detector and the first sampling
hole position at 'Hole Position # 1'. For the other positions, specify the number of
bends between the previous sampling hole position and this sampling hole
position.

Pipe Internal Diameter

This option is normally not used. If the 'Stepped' pipe diameter option is selected in
cases involving very long pipes, it is possible to enter the internal diameter of the
section of pipe immediately preceding this sampling hole position.

It is possible to reduce the internal diameter of the sample tube as you move
further away from the detector. This will improve the transport time, but possibly at
the expense of sampling hole airflow share and balance.

Capillary Tube Internal Diameter

If capillary tubes are used, their internal diameter must be entered so that the air
velocities can be calculated. If short, rigid sample tube droppers are used, these
should be treated as capillary tubes and their lengths as well as sampling hole size
entered.

If multiple sampling holes exist at a sampling hole position with sample tubes, the
Asyst Tool assumes that all of those tubes at that position are identical in diameter.

Capillary Tube Length
The length of capillary tube(s) or dropper(s) used at a given position can be
entered. (Maximum length of capillary tubes: 2 m).

If multiple sampling holes exist at a sampling hole position with sample tubes, the
Asyst Tool assumes that all of those tubes at that position are identical in diameter.

'Capillary Tube Coil Diameter'

Capillaries are often coiled or curved, so the coil diameter can be entered.

If multiple sampling holes exist at a sampling hole position with sample tubes, the
Asyst Tool assumes that all of those tubes at that position are identical in coil
diameter.
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2527

2528

28

Aspirating holes

The number of holes (sampling points) at each position can be set from 0 to 4.

Generally, one sampling hole is used. However, the pipe may be run above a
corridor, with capillary tubes directed toward opposite rooms, requiring two
sampling points at each location. Or the pipe may be run above a wall, with one
tube directed toward each of four adjacent rooms at the cross-point.

'0' sampling holes can be used to simulate a blocked sampling hole.

If multiple sampling holes are used without capillary tubes, then the Asyst Tool
assumes that all of these sampling holes are sampling air from the same source
and adds together their effect.

Crosswind

This option is rarely used as the sampling holes are normally positioned 30
degrees off-center in relation to the oncoming airflow.

However, if the sampling hole is placed at 90 degrees to the airflow then with this
option it is possible to see the effect of the crosswind.

Enter the crosswind velocity at each sampling hole to see the effect of external
flows such as mechanical ventilation. The Asyst Tool is configured to calculate
based on the worst-case scenario (90 degrees in relation to pipe and hole).
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254

'Calculate’ Button

If you click on the 'Calculate’ button ('S30"), the Asyst Tool calculates the airflow
through each of the sampling holes and the end vent along the pipe.

The Asyst Tool then displays the results of the calculation at 'S29' for each
sampling hole position and at 'S33' for the pipe, and displays the sector airflow at
'S28'.

The pipe results are also displayed on the 'System Results' screen.

If the entered values prevent a valid calculation, the Asyst Tool displays a warning.

Changing the checkboxes at 'S31' alters either the calculation performed or the
displayed result. If you select the 'Balanced Hole Flow' option, the Asyst Tool
calculates and displays the hole diameters necessary to balance the flow of air and
smoke through each sampling hole. If you deselect this option, the Asyst Tool
reverts to the previous hole diameters.

If you select the 'Hole Sensitivity' option, the Asyst Tool displays the quantity of
smoke required at each sampling hole to activate a fire alarm. If you deselect this
option, the Asyst Tool displays the percentage airflow through each sampling hole.

The drop-down list of 'Special Options' at 'S32' allows additional or different
information to be displayed following a calculation.

'Propose Solution' Button

In 'Scientific’ mode, the 'Propose Solution' button is only available when the 'Hole
Size Precision' has been set to medium.

If you click on the 'Propose Solution' button ('S30'), the Asyst Tool calculates the
airflow through each of the sampling holes and the end vent along the pipe in the
project. The Asyst Tool uses all of the entered values about each pipe and each

sampling hole in those pipes, rather than the actual sampling hole diameters and
the end vent diameters.

Following the calculations, the Asyst Tool displays the most suitable combination of
sampling hole and end vent sizes for each pipe. It shows the values for the current
pipe on the 'Sector Details' screen and for all of the pipes on the 'System Results'
screen.

If the entered values prevent a valid calculation, the Asyst Tool displays a warning.
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2.5.5 Displaying Results (Scientific Mode)

30

In 'Scientific' mode, the results for each sampling hole position are displayed on the

'Sector Details' screen.

'Zone Details | System Details Sector Details |Svslem Results | Schematics |

Pipe Number E AR EREENE EndVent [6.0 mm
" Fixed 18 m
Pipe Length (25,0 m Ambient Relative Pressure = |0.0 Pa
€ Variable
Pipe Internal Diameter |21.0 mm Eola Diamator Sector Flow 9.7 limin
Bend Radius |70 mm & Fixed 1.0 mm System Flow |? l/min
Number of Holes |9 3: " Variable System Flow Percentage |? %
Hole Postion  # 1 2 Y 4 5 6 7 8 V
Postion m 11.0 | 128 145 16.3 | 18.0 198 || 215 || 233 || 25,0
Bends # 2o BoBoBloBloEoBoBo =
Pipe Pressure  Pa 30 29 28 27 26 25 24 23 22
Hole Flow  I/min 03 03 0.2 0.2 0.2 0.2 02 02 78
Hole Sensitivity ~%/m 278 | 284 | 289 | 294 | 300 | 306 | 31.1 | 318 0.9
Transport Time  Sec 131 | 161 | 189 | 221 | 251 | 284 | 316 | 350 | 384

Trunk Length m

Special Options LI

I” Balanced Hole Flow
Propose

Soliton Calculate

V' Hole Sensitivity

Figure 12 'Sector Details' screen displaying results
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2551

2552

2553

2554

In addition to the usual results, additional calculated values can be displayed for
the pipe calculations or for the sampling tube calculations. In 'Scientific' mode, the
additional results are displayed on the 'System Results' screen.

'Zone Details | System Details | Sector Details System Results |Schematics]

Combine Separate Duplicate
Sector 1 2 3 4
Trunk Identifier [ A ‘ A ‘ A ‘
Trunk Length  m [100 [100 [100 ||
Trunk Hole Posttions  # [ 0 [ 0 [ 0 [
Pipe Length  m [ 250 [ 250 [ 250 | 200
First Position m [110 [110 [10 [ 40
Hole Spacing m ‘ 45 ‘ 45 ‘ 45 ‘ 3.7
Hole Posttions # [ 5 ‘ 5 [ 5 [ 6
Pipe Intemal Diameter mm [ 210 [ 210 [ 210 [ 210
Tube Intemal Diameter mm [ [ ‘ ‘
Sampling Hole mm [ 25 [ 25 [ 25 [ 25
End Vet mm [ 25 [ 25 [ 25 [ 25
Hole Share | % [ 802 [ 802 [[802 [ 836
Hole Balance | % [970 [970 [970 [ 805
Maximum Time = sec [ 775 ‘ 775 ‘ 775 ‘ 62.0
Ambiert Pressure  Pa [ 00 [ 00 [o00 [ o0
Sector Pressure  Pa [482 [ 482 [ 482 [ 482
Sectorflow Umn | 71 [ 71 [ 71 [ 103
Sector Share % [225 [ 225 [ 225 | 325

[~ Aspirator Settings

Parameter Set
Aspirator Power

Figure 13 'System Results' screen

Pipe Pressure

This is the air pressure within the pipe at that sampling hole position.

Hole Flow [I/min]

This is the airflow through the sampling hole(s) at that sampling position.

If multiple sampling holes are drilled into the pipe at a sampling position and that
sampling position does not have sample tubes fitted, the Asyst Tool displays the
sum of the flow though all of those sampling holes.

If sample tubes are fitted, the Asyst Tool assumes that each tube is sampling air
from a different environment and displays the flow through each sampling hole.

Hole Flow [%]

This is the hole airflow expressed as a percentage of the total airflow through the
pipe.

Hole Sensitivity

This is the level of smoke at a sampling hole that will trigger the fire alarm at the
detector.
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2.5.5.5 Transport Time

This is the time taken for smoke to travel from the sampling hole through any
sampling tube at that sampling hole and the pipe to the detector.

If the calculations in 'Normal' mode are outside the recommendations displayed, a
message will be displayed as shown in Figure 14.

Asvst x|

@W®% This software is unable to calculate a suitable solution. Either
"8»' modify the system design, such as selecting another detector or
= changing the pipe layout; or use the sdentific display mode which
allows for more control over the individual pipe and sampling hole
settings.

[

Figure 14 'Normal' mode: Message relating to calculations outside the recommendations

If the calculations in 'Scientific' mode are outside the recommended transport time,
this time is displayed in RED, as shown in Figure 15.

When the results are highlighted in RED, these are NOT the recommended
results and the configuration needs to be recalculated using fewer holes or
shorter pipe lengths!

| __[J

File Tools Configuraton Help
| New [z Open |of Save < Print | (@ www.siemens.com
|Pipe:1 Share: 55,7% Balance: 13.7% Max Time: 384 sec
' Zone Details | System Details Sector Details |System Results | Schematics |
: ~ ~Hole Spacing
Pipe Number E End Vent [6.0 mm
' Fixed 18 m
Pipe Length [25.0 m Ambient Relative Pressure + [0.0 Pa
" Variable
. ; Ui
Pipe Internal Diameter IZTG mm L le Diameter -~ Sector Flow |9.7 Imin
Bend Radius |70 mm ' Fixed 1.0 mm System Flow |? lmin
Number of Holes |9 3: " Variable System Flow Percentage |? %
Hole Posion  # 1 2 3 4 5 6 7 8 \
Postion m 110 28 45 | 163 || 180 || 198 | 21,5 || 233 || 25.0
Bends # 2o EH o= o =HoH o= o= o= o H
Pipe Pressure  Pa 30 29 28 27 26 25 24 23 22
Hole Flow  I/min 03 03 02 02 0.2 0.2 02 0.2 78
Hole Senstivity %/m 278 | 283 | 289 | 294 | 300 | 305 | 31.1 | 31.7 | 09
Transport Time ~ Sec 131 | 161 | 189 | 220 | 251 || 284 | 316 | 350 | 384
Trunk Length m SReealOptone j
z I” Balanced Hole Flow
ropose
Solution Calculate
M Hole Sensitivity

Scientific

Figure 15 'Scientific' mode: Display of results outside the recommendations
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| __[J

Advanced users can display extra information (see Figure 10); this is described in
sections 2.5.5.6 to 2.5.5.15. This information is shown when the relevant function
is selected from the 'Special Options' drop-down list (e.g., 'Pipe Details').

I, Asyst Siemens Aspirated Smoke Monitoring System

21|
File Tools Configuration Help
L) New [z5Open [ Save (S Print |@ www.siemens.com
|Pipe: 1 Share:845% Balance:93.7% MaxTime: 76,9 sec
' Zone Details | System Details Sector Details | System Results | Schematics |
Pipe Number E [1ABE SR EndVent |25 mm
' Fixed [ m
Pipe Length |25.0 m Ambient Relative Pressure = |0.0 Pa
" Variable
Pipe Internal Diameter |21,0 mm —Hole Di Sector Flow [11.5 limin
Bend Radius |70 mm ' Fixed 25 mm System Flow [34.9 I/min
Number of Holes |9 33 " Variable System Flow Percentage |44 %
Hole Posion # 1 2 3 4 5 6 7 8 \
Position m 11.0 || 128 45 || 163 || 180 || 198 || 21,5 || 233 | 25.0
Bends # zﬂoﬁoﬂoﬂoﬁoﬂoﬁoﬂoﬁ
Pipe Flow  |/min 115 | 101 8.8 4.5 6.2 4.9 37 25 12
Pipe Velocity m/sec 056 | 049 | 042 | 036 | 030 | 024 | 018 | 0.12 | 0.06
Pipe Reynolds 759 668 579 492 408 325 243 162 81
Pipe Friction 0843 | .0959 | .1105 |.1300 |.1570 | .1972 | 2637 |.3958 |.7868
Pressure Drop Pipe  Pa 0.6 12 10 | 09 | 07 | 06 | 04 | 03 | 0.1
Pressure Drop Jet  Pa 0.1 0.1 0.1 0.0 0.0 0.0 0.0 0.0 0.0
Pressure Drop Bends Pa 02 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Pipe Pressure  Pa 26 25 24 23 23 22 22 21 21
Hole Flow  I/min 14 13 1.3 13 13 12 1.2 12 12
Transport Time  Sec 179 | 206 | 236 | 273 | 316 | 372 | 443 | 556 | 769
e — — = .
uskiengts m ( Special Options |Pipe Details j )
o ~
~ —~
N " Balanced Hole Flow R — N ——— =
Sroc; utl e Calculate
¥ Hole Sensitivity
Sdentific
Figure 16 'Scientific' mode: Extra information with 'Pijpe Details' option
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{, Asyst Siemens Aspirated Smoke Monitoring System _1 D - 21|
File Tools Configuraton Help
[ New [ZFOpen [gf Save S Print | @ www.siemens.com
|Pipe:‘l Share: 84.5% Balance:93.7% Max Time: 76.3 sec
'Zone Details | System Details Sector Details ]Svstem Results | Schematics |
Pipe Number [1 = _':°|:i:a°'"g T EndVent [25  mm
" Fi A m
Pipe Length |25.0 m - Ambient Relative Pressure = [0.0 Pa
Variable
Pipe Internal Diameter [21.0 mm i ole Di Sector Flow |11.8 limin
Bend Radius |70 mm ' Fixed 25 mm System Flow |? lmin
Number of Holes |9 3: ¢ Variable System Flow Percentage |? %
Hole Posion # 1 2 3 4 5 6 7 8 \
Posttion m 110 || 128 || 145 || 163 || 180 || 198 || 215 || 233 || 25.0
Bends # 2 o Hlo o Hlo HoHoH o=l H
Tube Length m 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Pipe Pressure  Pa 27 26 25 24 24 23 23 22 22
Hole Flow  |/min 14 14 13 13 1.3 13 13 1.2 13
Tube Velocity m/sec 0.00 | 000 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00 | 0.00
Coil Radius  m 0.0 0.0 00 | 00 | OO | 00 | 00 | 00 0.0
Tube Friction 0.0000 | 0.0000 |0.0000 | 0.0000 | 0.0000 |0.0000 |0.0000 |0.0000 | 0.0000
Hole Pressure  Pa 27 26 25 24 24 23 23 22 22
Hole Diameter mm 25 25 25 25 25 25 25 25 25
Tube Time sec 0 0 0 0 0 0 0 0 0
Transport Time  Sec 187 | 214 | 243 | 279 || 321 | 376 | 445 | 556 | 763
o’ = - = = ~
Trunk Length m ( Special Options | Tube Details v )
~ e =
- I Balanced Hole Flow R =
ropose
Solution Calculate
¥ Hole Sensitivity
Scientific

Figure 17 'Scientific' mode: Extra information with 'Tube Details' option
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Fire Simulation
'Sector Details' Screen (Scientific Mode)

2.5.5.6 Pipe Flow

This is the flow rate of the air within the pipe at the sampling hole position.

2.5.5.7 Pipe Velocity

This is the velocity of the airflow within the pipe at the sampling hole position.

2.5.5.8 Pipe Reynolds

This is the friction value of the air flowing within the pipe at the sampling hole
position.

2.5.5.9 Pressure Drop Pipe

This is the pressure drop due to the airflow within the pipe section prior to the
sampling hole position.

2.5.5.10 Pressure Drop Jet

This is the pressure drop due to the airflow through the sampling hole at the
sampling hole position.

2.5.5.11 Pressure Drop Bends

This is the pressure drop due to the airflow through the bends in the pipe section
prior to the sampling hole position.

2.5.5.12 Tube Velocity

This is the velocity of the airflow within the sampling tube at the sampling hole
position.

2.5.5.13 Tube Friction

This is the friction value of the air flowing within the sampling tube at the sampling
hole position.

2.5.5.14 Hole Pressure

This is the air pressure across the sampling hole.

25515 Tube Time

This is the transport time for smoke to travel from the sampling orifice at the end of
the sampling tube to the pipe at the sampling hole position.
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2.5.5.16

2.5.5.17

2.5.5.18

2.5.5.19

2.5.5.20

2.5.5.21

Hole Share

The 'Hole Share' is a measure of the airflow through all the sample tubes in a pipe
(excluding the end vent), compared with the total airflow in that pipe. Generally, the
higher the result, the better the system design, but this comes at the expense of an
increase in the transport time.

Hole Balance

'Hole Balance' is a measure of the airflow through the sampling hole with the
lowest flow in a pipe, compared with the average airflow through all sampling holes
in that pipe (excluding the end vent). Generally, the higher the result, the better the
system design.

Maximum Time

This is the longest time taken for smoke to travel from a sampling hole to the
detector.

Sector Flow

This is the airflow at the detector end through the current sector (pipe).

When a pipe is calculated, this is the flow in that pipe assuming that all other pipes
in the project are identical to this pipe. Once the combined system has been
calculated allowing for each of the different pipes in the project, this value is
updated.

System Flow

This is the airflow through the detector aspirator from all of the pipes connected to
the detector.

System Flow Percentage

This is the share of 'System Flow' (see 2.5.5.20), expressed as a percentage. If the
flow share is greater than 80 % of the maximum airflow allowed for the detector,
then the result is colored red.
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2.6

'Sector Details' Screen (Normal Mode)

Figure 18 shows the 'Sector Details' screen when 'Normal' mode is selected.

{ Asyst Siemens Aspirated Smoke Monitoring System 101 x|
File Tools Configuration Help

New [ Open [g Save (= Print WwWw.sieme
= S41

IThe number of pipes in this fire zone =2

'Zone Details | System Details Sector Details |System Results | Schematics |

Pipe Number IE yole Spacmg Number of Holes |14 3:
& Fixed 0.8 m
Pipe Length |20.0 m
" Variable
Hole Posttion

Posttion m 10.0 10.8 131 14,6 154

Bends 2:]0::{8400j0joj|0j|0:315”j|[7)j|

£
N
W
-~
w
@
~
o
©w
=]

£ 3

Hole Position

Y
=
1
N
iy
w
=

Posttion m

Bends # o = o0 = 0:] Dj

Normal

Figure 18 'Sector Details' screen in ‘Normal' mode

This screen is used to enter the details of each sector (pipe) in the fire zone.

At 'S36' it is possible to select which pipe to edit or which pipe to view. The pipes
are numbered 1...4, allowing each pipe to be uniquely identified.

The pipe length is entered at 'S37' and the number of sampling hole positions in
the pipe at 'S39'".

If the spacing between holes is uniform then it may be entered at 'S38'; if it is
variable, selecting that option allows the individual positions or gaps between
positions to be entered at 'S40'. If the positions are to be entered as gaps or
distances between sampling hole positions, then check the box at 'S38'.

Section 'S40' can be used to enter the details specific to each sampling hole
position. This includes the sampling hole position or gap between holes and the
number of bends in the pipe section preceding this position.

In addition to these basic input fields, the fields for the following options are shown
based on the pipe settings made on the 'System Details' screen:

® Internal diameter and length of the sample tubes

® Number of holes at each sampling position

A help prompt or information is displayed at 'S41' for most of these input fields.
Refer to Section 2.5 for the details of the values to be entered.

In 'Normal' mode, it is not possible to enter the coil radius of capillary tubes,
crosswind values, or ambient relative pressure.
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'System Results' Screen (Scientific Mode)

Figure 19 shows the 'System Results' screen when 'Scientific' mode is selected.

I, Asyst Siemens Aspirated Smoke Monitoring System llﬂ
File Tools Configuration Help

New (5 Open Save (§Print | @@ www.siemens.com
= =

lPupe:‘ Share: 404% Balance: 100,0% Max Time: 66.7 sec

' Zone Details | System Details | Sector Details System Results | Schematics

Combine Separate Duplicate
D)
Sector 1 2
Trunk Identifier [ |
Trunk Length m
Trunk Hole Posttions  #
Pipe Length m 20,0 40,0
First Position m 10.0 1.0
Hole Spacing m ~0.0 38 i
Hole Positions  # 2 9
Pipe Intemal Diameter mm 210 210
Tube Intemal Diameter mm
Sampling Hole mm 25 25
End Vent mm 3.0 30
Hole Share % 404 853
Hole Balance % 100.0 63.8 ]
Maximum Time = sec 66.7 63.7
Ambient Pressure  Pa 0.0 0.0
Sector Pressure  Pa 101.9 95,5
Sector Flow  |/min 6.5 203
Sector Share % ? 7
Aspirator Settings
Parameter Set
Aspirator Power

Scientific

Figure 19 'System Results' screen in 'Scientific' mode

Before this screen is used in 'Scientific' mode, the 'Sector Details' screen is used to
optimize the results for the various pipes.

This screen is used to display the summary results of each sector (pipe) in the fire
zone and to combine the airflow through those pipes to calculate the airflow
through the entire system.

Elements on the 'System Results' Screen (Scientific Mode)

At 'S42' the summary results for each pipe are shown. Depending on the number of
pipes in the project a column is added to the table at 'S43'.

The tilde symbol (~) denotes an average value where stepped sizes have been
used.

The Asyst Tool cannot know the parameters of other pipes before their data has
been entered. Thus, when a result for a given pipe is calculated on the 'Sector
Details' screen, the Asyst Tool assumes that all pipes are identical for the time
being.
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2.7.2

2.7.3

'‘Duplicate’ Button

If two pipes are identical, then click on the 'Duplicate’ button at section 'S44' and
follow the prompts to copy the details of one pipe to another pipe. Only pipes that
have been calculated can be copied or duplicated.

To duplicate all of the parameters of another pipe, select the
pipe number to copy from and the pipe number to copy to:

Copy from pipe |1 vl Cancel

Copy to pipe |2 vl OK

Figure 20 Duplicate pipe screen

At section 'S45' select the pipe to copy from; this includes a drop down list of all of
the calculated pipes. Then select a pipe as a destination for the duplicate. Pipes
that have not yet been calculated can be selected from a drop-down list.

If all of the pipes have been calculated then following a prompt, all of the pipes will
be available to copy from and the copy to list will include all of the remaining
calculated pipes.

To accept the change, click on the 'OK' button; to cancel the change, click on the
'Cancel’ button ('S46").

'Combine' Button

Once all of the pipes in a project have been calculated, then click on the "Combine
button ('S44") to combine the system as a whole, based on the different individual
pipes actually specified.

Click on the 'Separate' button to return all the pipes to their pre-combined state.

39

Building Technologies

Fire Safety

ABV10340094_b_en_--
2014-01-31



Fire Simulation
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2.8 'System Results' Screen (Normal Mode)

Figure 21 shows the 'System Results' screen when 'Normal' mode is selected.

), Asyst Siemens Aspirated Smoke Monitoring System || _Zlil
File Tools Configuration Help

New [ Open Save Print WWW.Siemens.com
=

'Zone Details | System Details | Sector Details System Results | Schematics

[Hole Diameter ——— —<]
Propose
Solution @ & Fixed € Variable

;’z:t;';”“be” LTI Zi"";)"“e’“" LEREET g:;e Position Number | 5, iion (m) Hole Diameter (mm) | Hole Sensttivity (%/m) | Transport Time (sec—]
21 1 11.0 25 26 227
7 148 25 27 295
3 186 25 28 379
4 224 25 28 488
5 26.2 25 29 64.2
@ 6 300 30 19 90,0
2/A 21 1 11.0 25 26 22.7
2 14.8 25 27 295 i
3 186 25 28 379
4 224 25 28 488
5 26.2 25 29 64.2
6 300 30 19 90.0
3/B 21 1 40 25 23 118
2 72 25 24 17.0 J;l
< | »

Alarm Value | Typical Pre-Alarm Value | Typical Info Alarm Value Aspirator Power Setting | Parameter Set
» Empfindlichkeit 0.065 0.035 - |LO 4
mA 9.00 |7.25 575

Figure 21 'System Results' screen in 'Normal' mode

Normal

This screen is used to calculate and propose an optimum solution for all of the
pipes in the project, to display the results of each pipe in the fire zone, and to
display the aspirator and alarm settings to be used in the detector.

2.8.1 'Propose Solution' Button

If you click on the 'Propose Solution' button ('S47'), the Asyst Tool calculates the
airflow through each of the sampling holes and the end vent along the pipe in the
project. The Asyst Tool uses all of the entered values about each pipe and the
sampling holes in those pipes, rather than the pipe diameters and the actual
diameters of the sampling holes and end vent.

Following the calculations, the Asyst Tool displays the most suitable combination of
pipe diameters and sampling hole and end vent sizes for each pipe.

If the entered values prevent a valid calculation, the Asyst Tool displays a warning.
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28.2

28.3

284

'Hole Diameter’'
At 'S48' it is possible to select fixed or variable hole diameters.

If you select the "Fixed' option, the Asyst Tool uses the same hole diameter at
each sampling hole position. This simplifies the process of installing the piping, as
the same drill size can be used at each sampling hole position along the pipe.

If you select the 'Variable' option, the Asyst Tool balances the flow through each
sampling hole along the pipe. The advantage is that the sensitivity at each
sampling hole position is more uniform; the disadvantage is that the installer may
need to drill different hole sizes at each sampling hole position.

Pipe Results

The table at 'S49' displays the results and the hole sizes to be drilled at each
sampling hole position on each pipe in the project.
First column: 'Pipe Number / Trunk Identifier'

Displays the 'Pipe Number' and, if the pipe is part of a branched set of pipes, the
"Trunk Identifier' (trunk identifier letter) entered when the branched pipes were
defined. Refer to section 2.4.3 Branched Pipes.

Second column: 'Pipe Internal Diameter'

Displays the internal diameter of the pipe to be used for each sector (pipe number).
Third column: 'Hole Position Number(#)'

Displays the number of the pipe sampling hole positions.

Fourth column: 'Position (m)'

Displays the position as the distance between the detector and sampling hole
position.

Fifth column: 'Hole Diameter (mm)’

Displays the diameter of the sampling holes to be drilled at each position.
Sixth column: 'Hole Sensitivity (%/m)’

Displays the calculated sensitivity of the sampling holes at each position.
Seventh column: "Transport Time (sec)'

Displays the transport time taken for smoke to travel from a sampling hole to the
detector.

Detector settings

Section 'S50' displays the settings to be applied to the detector for the proposed
solution. Based on the characteristics of the detector and the selected output
methods, the required details are displayed.

'Alarm Value' is the value to be set in the detector that applies to the reported
sampling hole sensitivities. If parameter sets are being used then this is the alarm
value set in the detector by setting the required parameter set.

"Typical Pre-Alarm Value' is a value that can be set in the detector as the pre-alarm
setting. If parameter sets are being used then this is the pre-alarm value set in the
detector by setting the required parameter set.

"Typical Ino Alarm Value' is a value that can be set in the detector as the alarm
setting. If parameter sets are being used, then this is the alarm value set in the
detector by specifying the required parameter set.

If the detector alarm values are set using parameter sets, then the appropriate
parameter set number to be used to configure the detector is shown here.

If the detector has switchable aspirator power settings, the setting to be used is
shown here.
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2.9

'Schematics' Screen
Figure 22 shows the 'Schematics' screen.

' Zone Details | System Details | Sector Details | System Results  Schematics

Pipe1 20,0m @

10,0m

Pipe 2 40,0m
| T T T " " T " " T

11,0m

Zoom 222%

J_

Figure 22 'Schematics' screen

This screen is used to display the schematic arrangement of the piping connected
to the detector.

This schematic plan of the system is not a scaled drawing with all individual system
functions shown precisely in position. However, this simple plan should serve to
illustrate the major system features and highlight possible inconsistent data.

It is possible to zoom in on or out of the plan to increase or decrease the display
size and fit it into the space available on the screen or on the printed report.

Section 'S53' shows the schematic diagram of a pipe with sampling holes at
positions 1, 2, 3, and 9. There are no sampling holes at the remaining positions.

Section 'S52' is the schematic of a shorter pipe containing four sampling hole
positions and the end vent.
Grab and drag the zoom control 'S51" or click on the zoom bar to expand or shrink

the schematic drawing so that you can examine shorter or longer pipes, or pipes
with small gaps between adjacent sampling hole positions, more closely.

The zoom setting selected on this screen will be used when printing the project. If
necessary, use the zoom control to stretch or shrink the schematic to fit onto the
screen before printing. When printing is carried out, the Asyst Tool will issue a
warning if the schematic does not fit on one page.
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3 Hardware Reference Files

The Hardware Reference File contains the details of the available detectors and
the local fire safety standards to be used.

If the detector to be used in the project is not shown in the detector’'s drop-down
list, then you will need to obtain a new Hardware Reference File from Siemens.

3.1 Installing a New Hardware Reference File

To install this file, you will need to copy the file to your computer, into the current
location (directory) used by the Asyst Tool for Hardware Reference Files.

To find this file location, run the Asyst Tool and select 'Configuration'-'File
Location'. This shows the current location for the Hardware Reference File.

3.2 Changing a Hardware Reference File

To change the current Hardware Reference File used by the Asyst Tool, select
'Configuration'-»'Change Hardware Reference File', then select the new reference
file from the list of files.

3.3 Changing the Hardware Reference File Location

To change the location used to store the Hardware Reference Files, select
'Configuration'>'File Location'. You will find more information in section 4.2.

3.4 Project Files

When saving the project file, if a Hardware Reference File has previously been
selected, that file is saved as part of the project file.

This ensures that the project can be opened on other computers with the
Asyst Tool installed, even if these computers do not have the Hardware Reference
File installed.
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4 Other Functions and Screens

4.1 Information on the ASD Asyst Tool

Figure 23 shows the screen that appears if you select 'Help'-'About'.

x

Siemens Aspirated Smoke Monitoring System

Program Version F-FXS2055-XL_xx_x version 1.3.0.R
Release Date 07.06.2013

Reference File

Vv XX_1_13.0

File Name C:\Program Files
(x86)\Siemens\F-FXS2055\XL_xx_x-V1.3.0\F-ASD2302-XX
_1_13.0ref

Language File

V 130

File Path C:\Program Files
(x86)\Siemens\F-FXS2055\XL_xx_x-V1.3.0\

Copyright Copyright (C) 2010, Siemens AG. all rights reserved

Close

Figure 23 Information on the ASD Asyst Tool

This screen displays basic information about the Asyst Tool.
Section 'S56' shows the software version and release date.

Section 'S57' shows the version of the current Hardware Reference File used by
the Asyst Tool and the full name and location of that file.

Section 'S58' shows the version of the current Language File in use by the
Asyst Tool and the full name and location of that file.

Section 'S59' shows the Copyright statement.
Click on the 'Close' button to return to the main screen.
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4.2 Screen With Locations for Files

Figure 24 shows the screen with the locations for files, which appears if you select
'Configuration'>'File Locations'.

J Asyst Siemens Aspirated Smoke Monitoring System x|
To modify the default location of the listed files, selectthe file and click on the
Modify button
File Type File Location
Reference File C:\Program Files (x86)\Siemens\F-FXS2(
Language File C:\Program Files (x86)\Siemens\F-FXS2(C
Asyst Project Files C:\ProgramData\Siemens\F-FX52055 XL er
Image Files C:\Users\strittmd\Pictures
4 | |

Modify |
Cancel oK I

Figure 24 Screen with locations for files

This screen is used to show the current locations (directories) for storing specific
project and system files, and to modify those locations.

Section 'S60' shows the current locations.

42.1 Modify File Locations

Select the item to be changed by clicking on the item in the list at 'S60".

If you click on the 'Modify' button ('S61"), this opens another screen allowing you to
browse for a folder (directory) or create a new folder. Select an existing folder or
create a new folder. Click on the 'Close' button to return to the file locations screen.
The selected folder is now shown on the screen.

To accept the change, click on the 'OK' button; to cancel the change, click on the
'Cancel’ button ('S62').

° Modifying the location to be used by the Asyst Tool for either the Hardware
1 Reference Files or the Language Files does not move any of these files to the
location. If these files are not stored at the listed file location, then the Asyst Tool
will not be able to find them.
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4.3

4.3.1

46

'Data Backup Period' Screen

Figure 25 shows the screen for data backup periods, which appears if you select
"Tools'->'Data Backup Period'.

Asyst - Data Backup Period

Slide the pointer to setthe data backup period

Figure 25 'Data Backup Period' screen

This screen is used to change the data backup period for project files.

Backup copies of project files are created at regular intervals, ensuring that, if your
computer stops responding or there is a power failure, you will not lose your work.

The time interval can be set between 2...20 minutes.

Set Data Backup Period

Select 'Tools'»'Data Backup Period'.

Grab the pointer at 'S63' with the computer mouse and slide it either left or right
until the required period has been selected.

To accept the change, click on the 'OK' button; to cancel the change, click on the
'Cancel’ button ('S64").
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4.4

44.1

442

Design and Software Information

Figure 26 shows the screen that appears if you select 'Help'»'Design Information'.

# Asyst Siemens Aspirated Smoke Monitoring System = e 1[
Q) Back € Forward [ PrintSetup |Q PrintPreview (§Print <= Return to Asyst
Branched Pipes =

Capillary Tubes
Crosswind

End Vent

Fire Alarm Settings
Fire Standard

First Hole Position
Gap

Hole Balance

Hole Diameter

Hole Share

Hole Spacing
Maximum Time
Number of Holes
Number of Pipes
Output Method
Ovenview

Parameter Set

Pipe Internal Diameter
Pipe Length

Pipe Number

Project Image
Sampling Hole Sensitivity
Sector

System Flow Percentage
System Results
Transport Time Limit
Trunk Length

Zone Details

Overview

This Asyst system modelling program includes 5 pages for data entry or inspection, referred-to as: Zone Details, System Details, Sector Details, System
Results, and Schematics pages. In NORMAL mode, Asyst willgropose a solution using the data you provide. In SCIENTIFIC mode, Asyst is not prescriptive. It
permits a what-if analysis, to enhance your awareness of { factors governing efficient design

Zone Details

This page enables the project fire zone details to be entered. The comment area on this page provides a handy notepad. All site details and pipe data can be
conveniently stored on disk for future reference. Hard copy can also be printed-out in a page format consistent with the pipe system design data

Project Image o

Figure 26 Design and software information

This screen is used to display either design information by selecting 'Help'-'Design
Information' or software information by selecting 'Help'-'Program Information'. This
screen can remain open even when you are working with the Asyst Tool screens.

Section 'S65' contains the 'Back’, 'Forward', 'Print Setup', 'Print Preview', 'Print ',
and 'Return to Asyst' buttons.

Section 'S66' is an index to the help items while section 'S67' contains the actual
help text.

Navigation

It is possible to navigate through the help text using either the computer mouse or
the keyboard.

Clicking on an index item at 'S66' will take you to that item.
Click on the 'Top' button ('S68'") to return to the start of the index list.

Click on the 'Back' button ('S65') and 'Forward' button ('S65') to move to previously
visited sections of the help text.

Printing the Help Information
Click on the 'Print Setup’ button ('S65') to set the page layout.

Click on the 'Print Preview' button ('S65') to preview the pages before printing. This
option also contains menu functions allowing the print setup to be modified, the
printer to be selected, specific pages to be selected for printing and for those
pages to be printed.

Click on the 'Print ' button ('S65") to print the full document.
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Ambient effect Selecting the language, 8
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Temperature, 17
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Detail, 27
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Display in Schematics, 42

Distance, 27

End Vent, 26

Flow in the pipe, 35
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Pressure, 35

Pressure drop, 35

Sensitivity, 15, 31

Transport Time, 32, 36

D
Data, 11
Data backup, 46, 46
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Duplicating data, 39
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Crosswind, 28
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P
Piping
Bend Radius, 17, 25
Bends, 27
Branched pipe, 18, 19, 19, 20
Capillary tube, 27, 27, 27
Details, 23, 24
Diagram, 21
Inner diameter of pipe, 17, 25, 27
Length of single pipe, 20
Pipe length, 25
Pipe Number, 19
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